Conjoint Analysis

Research question: To what extent does each
component (factor) contribute to the total utility of a
product?

Assumption:
Total utility = Sum of all partial utilities

Data base of the Conjoint Analysis are preferences of
the interviewed subjects

Important application: Design of a new product
according to the requirements of the market



Conjoint Analysis

Factors and their values are defined by the researcher
In advance

The various combinations of the factor values yield
fictive products that are being ranked by the
iInterviewed persons

With Conjoint Analysis it is possible to derive metric
partial utilities from the ranking results

The summation of these partial utilities therefore
results in metric total utilities



Conjoint Analysis

m Independent variables: Object attributes

m  Dependent variable: Preferences of the interviewed
person for the fictive products

m  The utility structure of a number of persons can be
computed through aggregation of the single results
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s+ Factors and Factor Values

Important for the choice of factors and their values are:

> Relevance
Interference
Independence
Realisability

Compensatory relationships of the various factor
values

They do not constitute exclusion criteria
> Terminableness
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m Example: Attitudes towards dishwashing products
Clean: glass/dishes clean
Shiny: glass/dishes shiny

Smell: Non-perfumed/lemon fresh/intensive lemon
fresh

Quantity: small/medium/x-large

Packaging: loose in box/tab in plastic/tab in dissolving
plastic

Design: single/multi-colored/multi-colored + ball
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“ Survey Design

Definition of the incentives

Incentive = Combination of factor values that is

presented for rating

> Profile method: incentive results from the
combination of the different factor values of each
factor

> Two-factor method (Trade-off Analysis): Only two

factors are used at a time. For each of these
pairs a Trade-off-Matrix is set up

Which method is used depends on how demanding
the interview is for the respondent, the expenditure
of time and the closeness to reality
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“ Survey Design
Number of incentives

» Can increase very fast depending on the number
of factors and their values. It is advisable to
choose a subset (reduced design) out of all
theoretically possible incentives (full design).
There shouldn’t be more than 20 fictive products.

» Choice of the number can be based on random
selection (not very common) or systematic
selection

> Possible are symmetric (= all factors have the
same number of values) and asymmetric
(divergent number of values) designs

> Addelman developed several “Basic Plans” for
the construction of reduced asymmetric designs
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m Example (cont.): Attitudes towards dishwashing
products

> The full design consists of 2x2x3x3x3x3=324
different incentives

» The reduced design consists of 16 incentives/cards,
therefore we get a ranking from 1...16 for each

person Clean =hiny =mell Cluantity FPackaging Design STATUS CARD

1,00 200 1,00 200 200 1,00 1] 1
2,00 1,00 200 200 1,00 200 0 2
1,00 2,00 1,00 1,00 1,00 2,00 1] 3
2,00 200 200 1,00 200 3,00 1] 4
2,00 200 1,00 1,00 1,00 1,00 1] ]
1,00 1,00 3,00 1,00 2,00 2,00 1] G
2,00 1,00 1,00 3,00 200 1,00 1] 7
2,00 200 3o 200 1,00 1,00 0 d
1,00 1,00 1,00 1,00 1,00 1,00 1] 4
2,00 1,00 1,00 1,00 1,00 3,00 1] 10
1,00 200 3,00 3,00 1,00 3,00 1] 11
2,00 1,00 3,00 1,00 3,00 1,00 1] 12
1,00 1,00 2,00 3,00 1,00 1,00 1] 13
1,00 200 200 1,00 3,00 1,00 1] 14
1,00 1,00 1,00 200 3,00 3,00 ] 15
2,00 200 1,00 3,00 3,00 2,00 1] 16
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> The column “Card_" shows the numbering of the
cards

> The column “Status " can show the values 0, 1 or 2.

incentives that are part of the reduced design get the
number O

A value of 1 tells us that the corresponding card is a
so-called “holdout card” that isn’t used for the
estimation of the utility values, but for validation.

A value of 2 indicates a simulation card that isn’t
presented to the interviewed persons
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* Rating of the incentives
Possibilities:
> Ranking

> Rough classification into groups of different utility
with succeeding ranking within these groups.
Aggregation of these results leads to a total
ranking. Used when there is a large number of
iIncentives.

» Rating scales
> Paired comparison
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*» Estimation of the utility values

> Conjoint Analysis is used to determine partial
utilities (“partworths”) g for all factor values based
upon the ranked data

> Furthermore, with this partworths it is possible to
compute the metric total utilities y of all incentives
and the relative importance of the single object
attributes

> Individual Conjoint Analysis: For each person utility
values are computed

» Combined Conjoint Analysis: Only one value for
each factor category
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s Estimation of the utility values
>  The additive model of the Conjoint Analysis is defined as:

1M
yk:§ E ﬂjm'xjm
J=1 m=1

with

yk . estimated total utility for incentive k
o im partial utility for value (category) m of factor |

1 if incentive k has value m of factor j
0 else



Conjoint Analysis
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*» Estimation of the utility values

» Target criterion for the determination of the partial
utilities: The resulting total utilities should yield a
good representation of the empirically ranked data

> Related procedure for the determination of the
partial utilities: monotonous analysis of variance

> Metric solution — metric ANOVA

Non-metric solution — monotonous ANOVA (not
covered here)
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s Estimation of the utility values
> Model for the metric solution

3 M

J=1 m=1

Steps needed to get the solution:

Determination of x (= average of all ranks)

Determination of the mean rank for each factor
value (= which ranks did the interviewed person
assign on the average in conjunction with this
attribute?)
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\/

*» Estimation of the utility values

The average utility of a factor value then equals
the difference of its average empirical rank value
and u

The partial utilities g are OLS

Now it is possible to compute the total utility of
the incentives

> Missing values are being replaced by zeroes

> There shouldn’t be too much missing values in
order to prevent the analysis from breaking down
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“ Aggregation of the utility values

» For the comparability of the individual analyses of
the single persons it is necessary to carry out a
standardisation:

The factor value that yields the lowest utility
contribution is set to zero

The differences between the single partial utility
values and the lowest partial utility value are
computed:

ﬁ;m :ﬁjm _ﬂjMin
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< Aggregation of the utility values

The total utility value of the incentive that shows
the strongest preference among all persons is
set to one. The partial utility values are computed
accordingly:

*

— ﬁjm
J
Zmnc?x {,B;m}
J=1

> The importance of an attribute for the preference

change results from the utility range of the several
values of the attribute

IBjm
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N/

“ Aggregation of the utility values

> A high range value means that by varying the

concerning attribute a meaningful change of the
total utility can occur

> The relative importance of a factor can be obtained
by weighting on the sum of the ranges
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“ Aggregation of the utility values

> The largest standardised partial utility values allow
to make a statement about the relative importance
of the attributes at the same time

> Aggregation always implies the loss of information

If the aggregated utility structures are highly
heterogeneous, this loss of information is
substantial

> In this case, more homogeneous subgroups should
be formed by performing a Cluster Analysis
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Example (cont.): Attitudes towards dishwashing
products

» There is no graphical user interface available in
SPSS that would allow the performance of a
Conjoint Analysis. The SPSS-Syntax has to be used
In order to retrieve the required procedure
CONJOINT.

> After the Syntax-window has been opened, the
following commands should be entered:
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m Example (cont.): Attitudes towards dishwashing
products

3 Combined Conjoint.sps - SPSS Syntas Editor
Filz Edit Wiew Data Transform Snalvze Graphs Ubifities  Run Window  Help

=ele & « B | »| @ 7 |

TITLE "Canjoint Analysis".

COMNJOINT
plan = "ChdownloadiCiDesign. say”
fdata = "Chdownload\C A new. saw”

ffactars = Clean (DISCRETE) Shiny (DISCRETE) Smell (DISCRETE) Quantity (DISCRETE) Fackaging (DISCRETE) Design (DISCRETE)
frank = Qa OZb Qe 02d e Q2f O2g OZh Q2 Q2] 02k O] OZm OZn 2o O2Zp

fprint = all

futility = "ChdownloadhCMhTotal Utility. sav”

fplat = SUMMARY.

SUBTITLE "Litility “alues".
get file "ChdownloadhC N Total Utility, sav”,

LIST.
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The commands in the syntax have the following
meaning:

> With the TITLE — statement it is possible to define a title
for the results in the output window

> The actual Conjoint Analysis is performed with help of the
procedure CONJOINT. There are various subcommands
within this procedure:

- The PLAN subcommand tells CONJOINT which file
contains the data for the reduced design

Each of the following commands is preceded by a slash (/):
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- The subcommand DATA tells CONJOINT which file
contains the rankings of the respondents

- FACTORS is used to define the relationship between the
factors and the preference values (ranks) of the interviewed
persons. The relationships can be DISCRETE, LINEAR,
IDEAL or ANTIIDEAL. In this example, all of the
relationships are DISCRETE because only categorical data
is used. It means that no assumptions are made concerning
the relationship between variables and ranks.

- The subcommand RANK tells CONJOINT that the data is
coded in such a way that the sequence of the variables
corresponds to the sequence of the cards
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Alternatively, the subcommands SCORE or SEQUENCE
can be used.

- By the UTILITY subcommand, a file with the name
“Utility.sav” is being created, where various information is
saved. This information contains the following variables:

CONSTANT: The constant term of the conjoint
estimation

Several partial utility values

SCORE1 to SCORE16: Total utility values of the
reduced design

> With the SUBTITLE command, a new subsection of the
output is introduced

> With the “get file” statement the contents of the
“Utility.sav” file are printed in the output window



For our example, the results would be the following:

Litilities
I_Hility Importance Values
Estimate Std. Error
Clean Special additive to make 230 051 grlfan 923
glass clean i ' Iy 8,254
Special additive to make Smell. 21,727
dishes clean 230 091 Quantity 30,281
Shiny special additive ta make _— _ Packaging 13,265
glass shiny ! ! Design 18,118
special additive to make _ 997 091 fveraged Importance Scare
dishes shiny ! :
Smell han-perfumed -0a3 22
lemon fresh 639 143
intensive lemaon fresh -5485 143
Guantity standard {small 22 tahs) -.B30 22
standard (medium 44
tabs) L i Correlations=
standard (<-lage 88 tabs) -,004 43 al o
Packaging  packaged looge in a boy -, 299 122 T = U:81 Igmn
;:gglipa“‘agm taln 430 143 Kendall's tau 33 000
: ; a. Correlations hetween observed
s!ngle packageq tah in - 130 R X and estimated preferences
dissolving plasti
Design single cubicle - 616 Jg22
multi-colored cubicle 236 143
multi-colored cubicle +
integrated ball 280 43
(Constant) a,9a7 J10
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* Interpretation of the results

> The term “Averaged importance score” under the
box with the importance values tells us that a
Combined Conjoint Analysis has been performed.
These values give us a measure (in percent) of the
relative importance of the single factors for the
determination of the utilities. We can see that
‘quantity” is the most important factor whereas
“shiny” is the least important.

> The Correlation coefficients are a measure for the
quality of reproduction of the empirical data by the
results of the Conjoint analysis.

» The estimated partial values for the factor values
are given in the column “Utility Estimate”
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* Interpretation of the results

» Summaries of Importance and Ultility in form of bar
charts are also given

> The partial utility values allow the computation of
the total utility values for all the incentives. For
example, the total utility value for card 1 would be:

8,96-0,23-0,23-0,08+0,83+0,43-0,62=9,06

> The constant term 1 can be interpreted as base
utility, and the other factor values contrast with ¢ in
positive or negative direction
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“* Interpretation of the results

> Following this, the total utility values for all the cards
can be computed similarly. Like it was said above,
the results of this computations can be found in the
“Utility.sav” file (Score1 to Score16):

The wvariables are listed in the following order:

LINE

LINE

LINE

LINE

LINE
a

Mumder o

1: CONSTANT Cleanl CleanZ 3hinyl 3hinyZ 2melll Smell:

Z: Bwell3d Cuantityl Quantity2 Quantity3d Packagingl Packaging? Packagingl

3: Designl DesignZ Design3 SCORE1 ICOREZ JICORES SCORE4

4: SCORES SCCORE6 ZCORE7? SCOREZ SCORES SCCORE10 SCORE11

S5: SCORE1z 3ICCOREL3F SCORE14 ICORE1S SCORELA
CONSTANT: 5,96 -,23 F23 23 -,23 -, 08 L 6d

Smell3: -, 56 -,83 83 ,00 -,30 X -,13
Designl: -, B2 F28 38 9,07 10,52 7,52 9,58

SCORES: g el 8,23 9,14 8,32 7,13 8,58 g,0z
SCORE1Z: 7,28 g,67 -1 9,96 8,95

cases read: 1 Nuwlber of cases listed: 1
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* Interpretation of the results

> We can see that card 2 has the highest total utility
(10,82). A product that makes the dishes clean, the
glass shiny, has a lemon-fresh smell, a multi-
colored design and is packaged loose in a medium
sized box therefore is the most preferred product
out of the 16 alternatives.

> Here, just the results for the reduced design are
given. But it is also possible to compute total utilities
for all the products of the complete design, even
though they were not part of the interview.
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* Interpretation of the results

> ltis therefore possible to find out that, for example,
a product that is similar to card 2, except that the
box contains single packaged tabs, would have an

even higher total utility than card 2.
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% Clustering the partial utility values

> As aforementioned, a Cluster Analysis should be
performed before aggregating the results if the
aggregated utility structures are not homogeneous

> To get the data that is needed to do this, a new line
has to be inserted into the syntax:

TITLE "Conjoint Analysis".

COMJOINT
plan = "ChdownloadyCA\Design. sav"
fdata = "ChdownloadWC A2 new. sav”

Hactors = Clean (DISCRETE) Shiny (DISCRETE) Smell (DISCRETE) Quantity (DISCRETE) Packaging (DISCRETE) Design (DISCRETE)
/subject = Person

frank = Qg O2b QZc 02d O2e QZf Q2g C2h Q2 02) G2k Q2] 02m G2n 020 02p

fprint. = all

Jutility = "C:\downloadWC AP erson Ltility sav"

fplot = SUMMARY.

SUBTITLE "Lhiility “alues".

get file "ChdownloadhChPersan Utility. sav”.

LIST.
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% Clustering the partial utility values

> The results for each person are computed and
saved into the file “Person Ultility.sav™:

o|ela) E ol =kl Fled BlElE %9

1: Persaon | 1
Person COMNSTAMT Clean Clean2 Shiny1 Shiny2 amelll =mell2 Smell3
1 1,00 10,67 A3 -13 -13 b ke -5.33 37 217
2 200 8933 13 -13 -13 13 £33 7 217
3 3,00 10,38 25 -25 13 -13 5,33 242 2592
4 4,00 7.8a 38 -38 0o 0o 533 267 267
5 5,00 758 258 -25 0o 0o 5,33 267 267
B 6,00 792 -8 38 38 -4 5,33 292 -242
7 700 7 a2 33 -38 -25 25 5,00 -1,00 -4,00
g 8,00 6,42 38 - 38 -25 25 5,33 -B7 -4 67
9 2,00 692 1,00 -1,00 -13 13 533 -B7 -4 67
10 10,00 667 713 -13 -13 i3 5,33 207 -3.17
1 11,00 10,17 00 o 25 25 A7 79 - 56
12 12,00 942 33 - 35 38 -4 -4 .33 482 - 58
13 13,00 10,08 -25 25 B3 - B3 -33 a2 -,58
14 15,00 §92 - 13 A3 38 -4 -1,33 142 - 05
15 16,00 10,17 25 -25 -25 25 -1,50 1,88 -,35
1R 18 mn 71 - 13 13 - R 5 =2 1 AN AN
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% Clustering the partial utility values

> Now the formulae given in the section “Aggregation
of the utility values” are used to calculate the
standardised partial utility values (Transform >
Compute). It is reasonable to do this in two steps:

Compute the differences between the single
partial utility values and the lowest partial utility

value:
. x|
T arget % ariable:; MHumeric E=prezzion:
|5Clean = | CleanT - MIN[Clean1 Clean2) H
Type & Label... ___l
& Constant [CONSTZ o] <l>] 7lelsl Al _,4
Q&Special additive to L ] Tl et ey e Arithrmetic
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*» Clustering the partial utility values

Set the most preferred incentive to 1 and
compute the standardised partial utility values

X
i Humenc Expreszion;
= |5Clean?/SUM[MAS[SCleant SClean2) Max[S Shing1 S5hing2] MAX[SS -
mell 55 mell2],Mak[5 Duantite S Huantited, S Huantite 3] Mde S Packagin
Type & Label... | g1.5Packaging2 5Packaging3) Mak[SDeszignl S0eszign2. 50 esignl])
& Person [Person] = t—-’} Function group:
? Carstant [CONSTZ ] <] 7lele] 2l ;I
Special additive to Arithmetic
.‘:C'é} Srerial additive a -J —<-=J->—=J jJ—E-I-EJ COF & MNoncentral COF

> These two steps have to be repeated for each factor
value. After that, the partial utility values and the
standardised partial utility values can be attached to
the original data file
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% Clustering the partial utility values

> To do this, use Data > Merge files > Add variables

> If both data files are opened and the original data
file is the active one, the option “An open dataset”
can be chosen. Otherwise there is the possibility to
browse for the corresponding file:

Add Yariables to gZnew.say [DataSetz]

Select a dataset from the list of open datasets or from a file to merge with the active
dataset

¢ An open datasek

Person Ltility, sav [Datasetl]

" An external SPSS data file

Mon-5PS5 data Files must be opened in SPSS before they can be used as part of a merge,

Cantinue Zancel Help




Conjoint Analysis

\/
0’0

>

Clustering the partial utility values

We can exclude variables from the dataset that
aren’'t needed anymore (i.e., the SClean1 to
SDesign3 variables). The variables that aren’t
excluded form the new data set:

Add Yariables from Person Utility.say [DataSetl.] il
Excluded W ariables: Mew Active Dataset: oK I
SQuantityl [+] - MNLIuantity? [+] =
SQuantity2 [+] _I NG uantity3 [+] _I Faste |
S Quantity3 (+] E NPackaging] [+] |
SShiny [+] MPackaging? [+] Fesst
SShiny2 [+] _l MPackagingd [+]

SSmelll [+] esigni [+ Cancel |
55mell2 [+] =]
MDeszign3 [+] Help
Henarme.. | OCL_1 [+) -
[~ Match cases on key variablez in zorted files Kep Wariables:

(% Both hles provide cases

{ Nonrachyve datazet s keved fable m

{7 Bctive dataset is keped able

™ Indicate case source as vaniable: |snu:'u:e[l'|
[7] = Active dataset

[+] = Perzon Utility. zav [DataSetl]
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% Clustering the partial utility values

> The next step is the actual performance of the
Cluster Analysis using the menu Analyze >
Classify > K-means Cluster

Il K-Means Cluster Analysis A x|
& SPackagingl o] ‘Variables: ok,
ﬁSPackaginﬁ fNEIean'l ﬂ Past
& SPackaging? E & NClear?
g@SDesign'l fNShiny'l Reset
& SDesign2 & Nhing? | —
f SResans j Label Cazes by Help

Nurnber of Clusters: l2 [~ Methad
&+ |terate and classify ™ Classify only

r Cluzter Centers
[ Fiead initiak

7 Operdataset I d

{5 Extermal data file Eilg.. |
[ white final:

% hew dataset |

) Matafile File... |

Iterate... | Save... Options. .
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% Clustering the partial utility values

> All the standardised variables from NClean1 to
NDesign3 are used as input

> To save the results of the Cluster Analysis in the
data file, the box “Cluster Membership” in the
“Save”-menu has to be checked

» Itis necessary to try different numbers of clusters to
find out what the (as regards content) best solution
IS

» Cross-classifying the variable for the Cluster
membership with certain demographic variables is
needed to assess the best Cluster solution



Conjoint Analysis

% Clustering the partial utility values
> If the Cluster solution has finally been found, it is
possible to compute an Combined Conjoint Analysis
for each Cluster separately (using Data > Select
Cases)
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